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Лабораторная работа № 1 

 

Основы работы в пакете создания мультимедиа-продукта. Создание изображений и 

библиотек символов в программном средстве создания мультимедиа-продукта 

 (векторная графика) 

 

Цель работы изучить основные инструменты на панели инструментов. Получить 

навыки создания изображений. Научиться создавать и редактировать символы и 

текстовые оформления, изменять свойства экземпляров символов в клипе. 

 

Краткие теоретически сведения 

Инструменты выделения 

А. Инструмент «Selection» («Выделение») –этот инструмент позволяет 

нам выбрать на монтажном столе произвольную область прямоугольной формы, все 

объекты, и части объектов попавшие в эту область. 

 

Упражнение 1: Выделите круг и переместите его в другое место 

монтажного стола. 

1. Нарисуйте круг. 

2. Выберите инструмент «Selecrion». 

3. Растяните область выделения, удерживая нажатой левую кнопку– мыши, 

так чтобы выделился весь круг. Обратите внимание, что выделенные элементы 

изменяют свой цвет, как бы покрываясь сеточкой. 

4. Если на выделенном объекте нажать и удерживать левую кнопку мыши, 

то. двигая курсором, мы сможем изменять положение выделенного фрагмента. 

Если мы просто щёлкнем курсором по какой–либо отдельной части нашего 

рисунка – выделится именно эта часть. 

 

Упражнение 2: Изменить форму объекта(круга). 

1. Наведите курсор на границу не выделенного объекта, около стрелочки 

появляется изображение дуги. 

2. Нажав и удерживая левую кнопку мыши, измените форму объекта. 

 

При выборе инструмента «Selection», в разделе «Options» появляются три 

дополнительные кнопки 

Кнопка  «Snap to Object» («Привязка к объекту») – позволяет связывать 

перемещаемый объект с другим 

Кнопка  «Smooth» («Сглаживание») – сглаживает ломаную линию, 

преобразуя ее в кривую. 

Кнопка «Straighten» («Выпрямление») – уменьшает изогнутость линии. 
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В. Инструмент  «Subselection» («Лодвыделенне») – позволяет выделить 

объект или несколько объектов целиком  

 

Упражнение 3: Изменить форм объекта (круга). 

1. Выберете инструмент «Subselection». Все объекты, хоть краем попавшие в 

область выделения, оказываются полностью выделенными. 

2. Выделите круг. Выделенный объект окаймляется зеленой линией, на 

которой имеются небольшие зеленые точки, иначе называемые углами. Если 

навести курсор на узел, курсор изменится н приобретет вил острого треугольника 

3. Нажмите левую кнопку мыши и удерживая ее. движениями курсора 

перетаскивайте отдельные узлы, меняя форму объекта. 

 

С. Действия инструмента  «Lasso» («Лассо») схоже с действием 

инструмент «Selection». При выделении инструментом «Lasso» выделяется не 

прямоугольная, а произвольная область. 

 

Инструменты модификации 

Инструмент  «Free Transform» («Свободная трансформация») – позволяет 

применять различные способы трансформации объекта. 

 

Упражнение 4: Измените форму прямоугольника, поверните его под 

любым углом. 

1. Нарисуйте прямоугольник 

2. Выберите инструмент "Free Transform» 

3. Выделите прямоугольник при помогли инструмента «Free Transform» 

путем растягивания области выделения. Вокруг прямоугольника образовалась 

черная рамка с небольшими черными квадратиками на углах. 

4. Нажав и удерживая левую кнопку мыши на любом из этих квадратиков и 

двигая курсор, растягивайте прямоугольник в любую сторону 

5. При приближении курсора к одному из углов выделения, курсор 

принимает вид круглой стрелки. Нажав и удерживая левую кнопку мыши, двигайте 

курсор, чтоб вращать прямоугольник. 

 

В разделе «Options» имеются дополнительные кнопки. 

Кнопка  «Rotate and Skew» («Поворот н наклон») –доступной 

трансформацию вращения и наклона, гд 

Кнопка «Scale» («Растяжение») – позволяет сделать доступной 

трансформацию масштабирования. 

Кнопка  «Distort» («Искажение») – позволяет сделать доступной 

трансформацию искажения перспективы 
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Кнопка  «Envelope» («Изгиб») – позволяет сделать доступной 

трансформацию изгиба. Рисование линий 

 

Рисование линий 

 

D. Рассмотрим инструменты рисования на панели инструментов. Начнем наше 

изучение с инструмента  «Line» («Линия»). Этот инструмент позволяет 

рисовать нам прямые линии. Обратите внимание, что свойства на панели 

«Properties» соответствуют выбранному инструменту. Так, на панели «Properties» 

мы можем выбрать толщину линии, изменить тип линии и поменять цвет линии 

Цвет линии можно также выбрать н на панели инструментов. 

 

Упражнение 5: Нарисуйте прямую. 

Для этого нужно нажать и удерживать левую кнопку мыши на рабочем поле и, 

не отпуская кнопки мыши, протянуть курсор в нужном направлении. 

 

E. Следующий инструмент – «Реп» («Перо») Он позволяет рисовать 

кривые от точки к точке. 

 

Упражнение 6: Нарисуйте кривую 

1. Щелкайте левой кнопкой мыши в разных точках рабочего поля и они. 

соединяясь линиями, образуют ломаную. 

2. Нажмите левую кнопку мыши, удерживайте ее и передвигая курсором, 

сможете установить кривизну линии. На панели «Properties» находятся те же 

атрибуты, что и при выделенном инструменте «Line» 

3. Если вы замкнете кривую, нарисовав тем самым фигуру, то внутренности 

фигуры будут окрашены в цвет заливки. 

 

Рисование фигур 

Инструментами рисования можно создавать не только линии, но и фигуры 

произвольной формы. 

 

F. Инструмент  «Rectangle» («Прямоугольник»). Этот инструмент 

позволяет рисовать прямоугольник, а если удерживать клавишу «Shift», то квадрат. 

 

G. Аналогично инструмент  «Oval» («Овал»). 

 

Упражнение 7: Нарисуйте прямоугольник. 

 

Упражнение 8: Нарисуйте овал. 
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Упражнение 9: Нарисуйте прямоугольник с закругленными краями 

1. Ha панели инструментов, в разделе «Options». нажмите новую кнопку «Set 

Corner Radius» («Установить радиус угла») и в открывшемся окне введите значение 

радиуса угла. 

2. Нажмите «ОК». 

 

Упражнение 10: Нарисуйте  многоугольник. 

1. Нажмите на кнопку инструмента «Rectangle» н удерживайте 

нажатой кнопку мыши. В выпавшем меню выберите другой 

инструмент – «PolyStar» («Многоугольник»). 

2. Этот инструмент позволяет рисовать многоугольник 

 

Упражнение 11: Нарисуйте многоугольник– звезду. 

1.Нарисуем многоугольник. 

2.Обратнте внимание, на панели «Properties» появилась кнопка «Options» 

(«Опции»). Нажмите ее. 

З.В выпадающем меню «$tу1е» («Стиль») выберите стиль многоугольника. 

Здесь предложено два варианта «Polygon» («Многоугшьник») и «Star» («Звезда»). 

Выберите вариант «Star» Ниже в поле «Number of Sides» («Число сторон») введите 

число сторон нашего многоугольника. 

4. Поле «Star point size» («Размер нейтральной точки звезды») задает степень 

остроты углов звезды. Чем меньше это значение, тем ближе будут утлы к центру. В 

случае если выбрана не звезда, а прямоугольник, значение в этом поле не будет 

влиять на внешний вид фигуры. Нарисуем звезду с малым показателем «Star point 

size». для этого введем значение 0.1. (Измените показатели на 1– это максимально 

тупой угол звезды). 

5.Нажмите «ОК» 

 

Н. Инструмент  «Pencil» («Карандаш») позволяет рисовать произвольные 

кривые. Кривая рисуется движением курсора при нажатой левой кнопке мыши. Этот 

инструмент является средством для рисования различных контуров. На панели 

«Properties» у инструмента «Pencil» можно настроить цвет, толщину и тип рисуемой 

линии. В разделе «Options» находится кнопка, позволяющая изменить степень 

сглаживания кривой. 

 

Кнопка  «Ink» («Чернила») – сглаживания практически не будет. 

Кнопка  «Straighten» («Выпрямление») – сглаживание будет 

максимальным. 

Кнопка  «Smooth» («Сглаживание») – этот вариант является 

промежуточным, сглаживание будет средним. 
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Упражнение 12: Нарисуйте инструментом карандаш произвольный Рис. 

 

I. Инструмент «Brush» («Кисть») является имитацией художественной 

кисти. Рисуемые ими линии и объекты являются не контурами, а заливкой. 

 

Упражнение 13: Нарисуйте линию инструментом Кисть. 

1. В разделе «Options» на панели инструментов измените размер кисти. 

Раскройте выпадающее меню «Brush Size» («Размер кисти») и в выпавшем меню 

выберите максимальный размер кисти. 

2. Также можно изменить форму кисти. Раскройте выпадающее меню «Brush 

Shape» («Форма кисти») и выберите самый нижний из типов кисти, в виде сильно 

наклоненной палочки.  

3. На панели «Properties» выберите цвет кисти. Обратите внимание, цвет 

кисти – это цвет заливки, а не цвет контура. 

4. Нарисуйте линию. 

 

J. Инструмент  «Ink Воtt1е» («Бутылка чернил») позволяет нарисовать 

контур у объекта однородного цвета. который представляет собой заливку Для 

применения инструмента нужно щелкнуть курсором на нужном объекте. На панели 

«Properties» можно выбрать тип контура, его цвет и толщину. 

 

Упражнение 14: Измените цвет и форму контура у любого объекта. 

 

К. Инструмент  «Paint Bucket» («Ведерко краски») окрашивает в 

выбранный цвет заливки объекты, ограниченные контуром, или однотонные 

объекты. Для применения этого инструмента нужно щёлкнуть внутри замкнутого 

контура нли на однотонном объекте. На панели «Properties» доступен только выбор 

цвета заливки. На панели инструментов, в разделе «Options» нажмите кнопку «Gap 

Size» («Размер промежутка»). В этом меню можно указать, насколько должен быть 

замкнут контур, чтобы можно было залить его внутри при помошн инструмента 

«Paint Bucket». 

 

Упражнение 15: Измените цвет заливки у любого объекта. 

 

L. Инструмент  «Еуеdroрреr» («Пипетка») позволяет нам выбрать 

необходимый цвет из имеющихся объектов на монтажном столе. Для выбора пвета 

достаточно щелкнуть прямо на изображении. При этом если щелчок был сделан на 

контуре, изменится цвет контура, а если щелчок был сделан на заливке, то 

изменится цвет заливки. 

 

Внимание, цвет кисти – это цвет заливки, а не цвет контура. 
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М. Инструмент  «Eraser» («Ластик») позволяет стирать произвольные 

области объектов. В разделе «Options» на панели инструментов можно изменить 

размер и форму ластика. Раскройте меню «Eraser shape», в выпадающем меню 

выберите максимальный размер круглой старательной резинки. 

 

Упражнение 16: Рассмотрите все способы работы инструмента Ластик. 

 

Упражнение 17. Начальные сведения о рисовании 

Выполнить действия, описанные в уроке “Рисование.fla”. 

 

Задание 1 

Сохраните вашу работу под именем «Практика по лабораторной работе № 1». 

Создайте отчет. 

 

Инструменты рисования 

Инструменты рисования можно разделить на три типа: инструменты, 

задающие одновременно и контуры, и заливки; инструменты создающие только 

контуры и инструменты, создающие только заливки. 

К инструментам первого типа относятся инструменты Oval (овал) и Rectangle 

(прямоугольник). Цвета контура и заливки определяются установленными к 

моменту использования этих инструментов. 

Для определения свойств рисуемых объектов инструменты имеют 

модификаторы в области Options (настройки), а также панель Properties в нижней 

части окна. Инструмент Rectangle имеет модификатор Round Rectangle Radius 

(радиус скругления углов). В панели Properties (в нижней части окна) можно 

выбирать цвет и другие свойства фигуры. 

Для получения правильной геометрической фигуры (круга или квадрата) 

необходимо удерживать нажатой клавишу Shift. 

Ко второму типу инструментов рисования относятся Pencil (карандаш), Line 

(линия) и Pen (перо). 

Инструмент Line используется для рисования прямых линий. Инструмент 

Pencil в отличие от инструмента Line, вычерчивает всю траекторию движения 

мыши и имеет следующие режимы рисования: 

– Straighten (выпрямление) позволяет преобразовать нарисованную линию в 

ломанную;  

– Smooth (сглажевание) позволяет сгладить нарисованную линию; 

– Ink (чернила) оставляет нарисованную линию без изменений. 

Для получения линии под углом расположения кратным 45о удерживайте 

нажатой клавишу Shift при рисовании. 

Инструмент Pen (перо) предназначен для рисования кривых Безье. 

Инструмент Eraser (ластик) используется для удаления произвольной части 

объекта и имеет форму круга или квадрата, каждый из которых в свою очередь 

имеет до пяти размеров.  

Модификаторы инструмента Eraser (ластик): 
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– Erase Normal (обычное стирание) – стираются все линии и заливки на 

активном слое.  

– Erase Fills (стирание заливки) – стирается только заливка, не затрагивая 

линии.  

– Erase Lines (стирание линий) – стираются только линии, не затрагивая 

заливку.  

– Erase Selected Fills (стирание выделенных заливок) – стираются только 

выделенные перед началом данной операции заливки. Линии не затрагиваются, 

даже если они выделены.  

– Erase Inside (стирание внутри) – стираются только те заливки, с которых вы 

начали данную операцию. Если Вы начали стирать внутри контура, который не 

имеет заливки, то ничто не будет стерто. 

Для рисования заливок используется инструмент Brush (кисть), который 

выводит штрихи, как будто вы красите кистью. Этот инструмент позволяет 

создавать специальные эффекты, включая каллиграфические эффекты и 

раскрашивание изображением импортированного растрового рисунка.  

Форму нарисованной фигуры можно изменить, потянув курсором мыши 

границу невыделенной фигуры.  

Для изменения цвета и других свойств существующей заливки используется 

инструмент Рaint bucket (ведро с краской). Для изменения цвета и других свойств 

контура – инструмент Ink bottle (бутылка чернил).  

Заливка бывает четырех типов: сплошная, радиальная, линейная и растровая. 

Создание типа заливки осуществляется в панели Color Mixer, которая открывается 

через пункт меню Window→Design Panels→Color Mixer. 

Инструмент Transform Fill служит для изменения геометрических свойств 

линейной, радиальной и растровой заливок. Для этого после выбора инструмента 

необходимо щелкнуть на заливке и управлять соответствующими появившимися 

маркерами (рис. 1). 

           
Рис.1.1. Виды маркеров для разных видов заливки 

(линейная, радиальная и растровая) 

 

Инструмент Selection (стрелка) служит для выделения контура или заливки, а 

также для изменения формы фигуры (если она не выделена).  

 

Символ 

Символ – особый объект, который создается один раз, и затем неоднократно 

используете в проекте. Символом может быть что угодно – от нарисованного 

рисунка до анимации. Символы позволяют сократить размеры конечного файла 
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фильма и упростить его редактирование. Символы также требуются для создания 

интерактивных фильмов. 

Любой созданный символ автоматически попадает в библиотеку. Для 

использования символа в проекте необходимо перетащить символ из библиотеки в 

проект. Причем в библиотеке будет храниться оригинал символа, а в проекте его 

экземпляр, который занимает мало места. Представление символа в фильме 

называется экземпляром символа. 

Каждый символ имеет свою рабочую область и свою шкалу времени. Таким 

образом, символы можно рассматривать как маленькие фильмы, экземпляры 

которых размещены внутри вашего проекта. 

Имеется 3 типа символов: 

– графика (graphic symbols) – статическая (неанимированная) графика. 

– клипы (movie-clip symbols) – независимый фильм, содержащий все элементы 

главного фильма, включая звук, анимацию и кнопки. 

– кнопка (button symbols) – реагирует на движение курсора мыши и реализуют 

интерфейс с пользователем. 

Символы можно создавать следующим образом: 

1) преобразованием элементов рабочей области (выделите эти элементы и 

выберите пункт меню Insert→Convert to Symbol. В диалоговом окне выберите имя 

символа и тип); 

2) созданием пустого символа, который затем заполнить содержимым. Для 

этого выберите пункт меню Insert→New Symbol. В диалоговом окне выберите имя 

символа и тип. После этого автоматически осуществляется переход в режим 

редактирования символа. Для выхода из режима редактирования символа в режим 

редактирования сцены выберите пункт меню Edit→Edit Movie; 

3) можно использовать символы из других фильмов. Для этого выберите 

пункт меню File→Open as Library. 

Выберите пункт меню Window→Library, чтобы открыть окно библиотеки и 

убедиться в том, что новый символ был добавлен в библиотеку. 

Символ можно отредактировать в любой момент. После редактирования 

символа все экземпляры этого символа также меняются.  

Для редактирования символа дважды щелкните на экземпляре символа, 

находящегося на рабочем столе, или выберите пункт меню Edit in Place или Edit in 

new window.  

Для редактирования свойств экземпляра символа (без изменения символа) 

служит панель Property. В ней можно изменять цвет, размеры, тип экземпляра. 

Также свойства экземпляра можно менять с помощью инструмента Free Transform.  

 

Текст 

Текст вводится, содержится и обрабатывается в текстовом блоке. Текстовые 

блоки могут быть трех типов: 

– Static Text используется как для создания объектов анимации, так и для 

вывода на экран текстового сопровождения; 
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– Input Text предназначен для взаимодействия с пользователем, 

просматривающем анимацию;  

– Dynamic Text предназначен для отображения на экране результатов работы 

программы Flash. 

Текстовые блоки Input Text и Dynamic Text используются для того, чтобы 

анимация стала интерактивной. Текстовый блок Static Text широко используется 

для создания графических изображений.  

Создать текстовый блок можно с помощью инструмента Text (Текст). После 

выбора инструмента Text щелкните в рабочей области. Появится однострочный 

текстовый блок. По мере ввода текста ширина блока будет автоматически 

увеличиваться, пока вы для перехода на новую строку не нажмете на клавишу 

Enter. Такой блок называется блоком фиксированной высоты.  

Если при создании текстового блока растянуть его, задав ширину блока, то 

длина строки остается постоянной. Слова в таком блоке переносятся автоматически, 

увеличивая тем самым количество строк. Такой блок называется блоком 

фиксированной ширины. 

Панель Properties для текстового блока предлагает обычный набор 

возможностей для форматирования, позволяя выбирать шрифт, размер кегля, стиль, 

интервал, цвет и тип выравнивания. С помощью инструмента Free Transform 

можно трансформировать текст как объект – вращать, масштабировать, сдвигать и 

зеркально отражать его, сохраняя возможность редактирования символов.  

Для изменения формы, заливки и других манипуляций, текст конвертируется в 

его графическое представление с помощью пункта меню Modify→Break Apart (2 

раза). Символы выбранного блока будут сконвертированы в графические формы на 

рабочем поле. 

После конвертирования текста в графическое представление, редактировать 

его как текст уже невозможно.  

 

Задание 2. Создание кружевного узора 

1. Чтобы нарисовать ажурную «снежинку» или звезду, сначала создадим 

вспомогательный шаблон (рис.1.2а). Для этого нарисуем вытянутый прямоугольник. 

Используя инструмент Selection, удалим из нарисованного шаблона заливку и 

слегка деформируем контур.  

2. Следующим шагом, используя инструмент Transform, перенесем центр 

вращения, на короткую сторону нарисованного шаблона.  

3. После этого на панели Transform (Windows→Desing Panels→Trasform) 

зададим угол поворота копии Rotate 18о. Несколько раз нажмите кнопку Copy And 

Apply Transform на этой панели. При каждом нажатии этой кнопки появляется 

новая копия шаблона, повернутая на заданный угол относительно предыдущей 

копии. 

На рис. 1.2б представлен полученный кружевной узор. 
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Рис.1.2. Создание кружевного узора 

 

Задание 3. Букет цветов 

1. Нарисуйте небольшой овал произвольного цвета, который впоследствии 

станет основой лепестка и листа цветка (рис. 1.3а).  

2. Не выделяя овал, слегка измените его форму (рис. 1.3б) инструментом 

Selection. Для этого поднесите курсор к овалу и «поймайте» момент, когда около 

курсора появится небольшая дуга. Эта дуга показывает готовность овала к 

деформации. Для деформации нажать на кнопку мыши и немного перенести.  

3. Выделите деформированный овал инструментом Selection. Удерживая 

клавишу Ctrl, перенесите его на другое место. 

4. Выделите полученную копию инструментом Free Transform. Она окажется 

окруженной вспомогательным прямоугольником, на котором находятся несколько 

маркеров.  

5. Поднесите курсор к угловому маркеру и «поймайте» момент, когда около 

этого маркера появится дугообразная стрелочка, что показывает готовность к 

повороту. Поверните копию на угол порядка 10о. 

6. Перенесите повернутую копию и наложим её на оригинал. Для этого 

воспользуемся инструментом Selection. Получено два лепестка. 

7. Продолжите процедуру копирования до тех пор, пока количество лепестков 

не станет достаточным. На каждом этапе можно слегка изменить форму лепестков. 

8. Измените цвет каждого лепестка инструментом Paint bucket. 

9. Листья рисуются аналогично лепесткам. Для создания листьев используется 

та же заготовка. 

10. Выделите весь цветок с помощью инструмента Selection и создадим 

несколько его копий. Для этого, удерживая клавишу Ctrl, перенесите изображение. 

11. Измените пропорции и размеры каждой копии, чтобы придать ей 

индивидуальность. 

12. Сдвиньте все копии поближе и получите букет (рис. 1.3). 
 

             
а                              б                                       в                                              г 

Рис.1.3. Преобразование овала в букет цветов 
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Задание 4. Радуга 

1. Нарисуйте круг в центре рабочего листа (рис. 1.4а). 

2. Выполните радиальную заливку круга. Для создания радиальной заливки 

используется панель Color Mixer (пункт меню Window→Design 

Panels→Color Mixer). Расположите заливку в центре с помощью инструмента 

Transform (рис. 1.4б). 

3. Нарисуйте горизонтальную линию по центру круга (рис. 1.4в). Снимите 

выделение и удалите линию и нижнюю часть круга. 

4. Нарисуйте круг радиусом меньше первого. Наложите нарисованный круг на 

оставшуюся половину первого круга. Затем удалите центр оставшейся 

половины круга. 

5. Отмасштабируйте радугу, растянув по горизонтали (рис. 1.4г). 

 

  
а                      б                    в                                                 г                               

Рис.1.4. Этапы создания радуги 

 

Задание 5. Витраж 

1. Создайте рабочий лист размером 400х400 (Modify→Movie). 

2. Нарисуйте в центре листа круг радиусом 150 (300х300) и радиальной 

заливкой. При помощи панели Info (Windows→Desing Panels→ Info) или панели 

Properties можно точно выставить координаты круга. 

3. Для получения фигуры на рис. 1.5 нарисуйте круг размером 100х100 в 

стороне от первого круга. Совместите его с первым кругом точно по координатам 

(200, 50). Снимите выделение, выделите и сместите в другое место (по координатам 

50, 200), снимите выделение, выделите и сместите аналогично в три другие позиции. 

Удалите второй круг. 

4. Добавьте к фигуре контур зеленого цвета при помощи Ink Bottle, щелкнув 

на внешней границе. 

5. Выделите весь контур с помощью инструмента Selection двойным щелчком. 

Отмасштабируйте на 90% и поверните контур на 45 градусов при помощи панели 

Trasform (пункт меню Windows→Desing Panels→Trasform) (рис. 1.5). 

6. Выделите контур и превратите его в заливку (Modify→Shape→ Convert 

Lines To Fills). Выберите линейную заливку и залейте контур (рис. 1.5). 

7. Затем инструментом Transform измените расположение заливки. 

8. Осуществите модификацию, представленную на рис. 1.5. 

 

г 
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Рис.1.5. Этапы создания витража 

 

Задание 6. Привидения 

1. Нарисуйте привидение, изображенное на рис. 1.6. 

2. Для того чтобы создать символ дважды щелкните на изображении 

привидения в рабочей области, выделив его, и выберите команду Modify→Convert 

to Symbol. 

3. В диалоговом окне Properties в качестве имени символа введите «ghost» и 

нажмите Enter. Теперь изображение привидения в рабочей области стал 

экземпляром символа, пока с нулевыми изменениями. 

4. Снимите выделение, а затем вновь выделите экземпляр символа ghost и 

перетащите его. Обратите внимание, что экземпляр перемещается как единый 

объект, а не как отдельные образующие его фигуры. 

5. Выберите команду Window→Library (Библиотека). Откроется окно 

библиотеки. Обратите внимание, что созданный символ появился в списке объектов 

окна библиотеки наряду с прочими символами текущего фильма. Экземпляр 

созданного символа можно использовать в любой части фильма.  

6. Перетащите символ привидения из окна библиотеки в рабочую область. 

При каждом перетаскивании создается новый экземпляр символа. 

7. Создайте несколько экземпляров. 

8. Используйте модификаторы Scale (Масштаб) и Rotate (Вращение) 

инструмента Selection, чтобы менять размеры и угол поворота созданных 

экземпляров символа (рис. 1.7).  

9. Измените яркость, контрастность или прозрачность экземпляров. Для этого 

выделите экземпляр в панели Properties, выберите параметры Color: Tint (Оттенок). 

Укажите, например, зеленый цвет в палитре цветов и передвиньте ползунок Tint на 

значение 50% (100% соответствует полной закраске символа выбранным цветом). 

10. На панели Properties символ можно сделать полупрозрачным. Выделите один из 

экземпляров и выберите пункт Alpha (Прозрачность). Необходимо получить 

изображение, представленное на рис. 1.8. 

 

 
Рис. 1.6. Привидение 

а б в 
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Рис. 1.7. Экземпляры символа 

 

 
Рис. 1.8. Результат выполнения  

 

Задание 7. Текст с градиентной заливкой 

Создадим текст с градиентной заливкой, представленный на рис. 1.9. 

1. Создайте новый клип. Установите размер клипа через пункт меню 

Modify→Document ... (Dimensions 350х160 px) . 

2. Нарисуйте фоновый прямоугольник размером 350х160px и разместить 

левый верхний угол по координатам 0,0. (Точный размер и положение можно задать 

через панель Info). 

3. Задайте заливку фона в виде радуги.  

4. Создайте текстовое поле на новом слое.  

Слои похожи на прозрачные листы, сложенные стопкой друг на друга. Когда 

вы создаёте новый клип, он содержит один слой. Вы можете добавить новые слои 

для удобства работы с изображениями, анимацией и другими элементами клипа, при 

этом можно рисовать и редактировать объекты на одном слое, не затрагивая 

объекты на других слоях. Через пустые места на слое видны объекты, которые 

находится слоем ниже. 

Слои можно скрывать, блокировать или показывать только контуры 

содержимого слоя (outlines), так же можно менять порядок расположения слоёв 

относительно друг друга. 

Чтобы создать слой, воспользуйтесь кнопкой Insert Layer внизу монтажной 

линейки. 

Чтобы рисовать на слое или изменять его параметры, он должен быть 

активным. Значок-карандаш, находящийся справа от названия слоя, указывает, что 

слой активен.  

5. Сделайте слой Layer 2 активным. Добавьте текст во второй слой. 

6. Используйте панель Character для выбора шрифта, размера, стиля и цвета. 
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7. Для изменения формы и других манипуляций сконвертируйте текст в его 

графическое представление (пункт меню Break Apart выполнить 2 раза).  

8. Для осуществления радиальной заливки верхней части букв, отличной от 

нижней, необходимо разбить текст на две части волнистой линией. Для этого 

выберите инструмент Pencil цвета, отличного от цвета текста (и выберите 

модификатор Ink). Таким образом, каждая буква будет разбита на верхнюю и 

нижнюю части. Отмените выделение линии и удалите ее. 

9. Выберите линейную заливку и залейте ею верхние части букв. При 

необходимости откорректируйте геометрические свойства заливок каждой части 

инструментом Fill Transform. Для масштабирования линейного градиента или 

заливки, перетащите квадратный маркер в центре блока ограничения. 

 

    
Рис.1.9. Этапы получения текста с градиентной заливкой 

 

Задание 8. Контурный текст 

Создадим контурный текст, представленный на рис. 1.10. 

1. Установите размер клипа 340х200px.  

2. На первом слое введите текст шрифтом Arial Cyr полужирный, синего 

цвета размером 88 пунктов c трекингом 11. 

3. Выделите текст с помощью инструмента Selection. Выполните команду 

Modify→Break Apart.  

4. Инструментом Ink Bottle добавьте контур серого цвета вокруг букв 

(выберите серый цвет и щелкните на внешнем контуре букв). 

5. Удерживая Shift, выделите контуры всех букв и скопируйте их на второй 

слой. Измените цвет линии на черный и установите толщину линии равной единице. 

6. Совместите контур букв во втором слое с контуром букв на первом слое (с 

помощью клавиш стрелок или мыши). 

   
Рис.1.10. Текст с контуром 

 

Задание 9. Задание для самостоятельного выполнения 
 

 
Рис. 1.11. Звезда 
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Рис. 1.12. Галактика 

 

 
Рис.1.13. Произвольная работа с текстом 

 

Контрольные вопросы 

 

1. Понятие компьютерной графики. 

2. Какие инструменты служат для выделения? 

3. Какие инструменты служат для рисования? 

4. Какие свойства имеются у инструментов «Заливка» и «Ластик»? 

5. Какие имеются возможности для модификации объектов? 

6. Инструменты для рисования линий, прямоугольников и овалов. 

7. Инструменты Pen, Pencil и Brush и их модификаторы. 

8. Инструменты для изменения свойств контура и заливки фигуры. 

9. Модификаторы Paint mode и Eraser mode. 

10. Инструмент Eraser и его модификаторы. 

11. Инструменты для выделения. 

12. Модификатор Smooth. 

13. Способы изменения формы и свойств линий и заливок. 

14. Панели Transform и Info. 

15. Понятие символа и его виды. 

16. Экземпляр символа. 

17. Способы создания текстовых полей. 

18. Изменение свойств текстового поля с помощью панели Character. 

19. Преобразование текста в фигуру. 

20. Понятие векторные изображения. 

21. Перечислить достоинства и недостатки различных типов графики. 

 



19 

 

Лабораторная работа № 2 

 

Основы работы в пакете создания мультимедиа-продукта. Создание изображений и 

библиотек символов в программном средстве создания мультимедиа-продукта 

(растровая графика) 

 

Цель работы изучить инструментарий графического редактора растровой 

графики и способы его настройки в различных режимах. Ознакомиться с 

плавающими панелями и их назначением. Научиться создавать и сохранять 

различные типы файлов. 

 

Краткие теоретически сведения 

В настоящее время имеется большое количество компьютерных программ, 

предназначенных для создания и обработки растровой графической информации. 

Они позволяют выполнять обработку фотографий, создавать книжные и 

журнальные иллюстрации на высоком профессиональном уровне, поэтому для 

примера выполнения мы выберем именно его. В основном работает с растровой 

графикой, хотя умеет обрабатывать и векторные изображения. Чаще всего такие 

изображения получают с помощью цифровой фотокамеры, при сканировании 

изображения или путем «захвата» кадра видеосъемки. 

 

Растровое изображение представляет собой матрицу разноцветных точек. Для 

хранения растровых изображений требуется большой объем памяти. Такие 

изображения сложно масштабировать и редактировать. 

Основными параметрами растрового изображения являются: 

− размер изображения (в дюймах, сантиметрах, точках, пиках и т.д.); 

− разрешение (количество пикселей на единицу размера); 

− глубина цвета (количество бит на один пиксель). 

 

Упражнение 1 

Запустите программу. Сразу после запуска вы видите в нем только меню, 

инструменты, палитры и панели. Самого изображения нет. Программа не создает 

пустого документа при открытии, т.к. он предназначен в основном для 

редактирования существующих изображений. В левом углу находится панель 

инструментов (рис.2.1). С помощью этих кнопок вы будете выделять, перемещать, 

трансформировать и окрашивать свое изображение. При нажатии любой кнопки, она 

становится активной – этот элемент выбран. На панели поместились не все кнопки – 

некоторые спрятаны.  
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Рис.2.1. Панель инструментов 

 

Создайте новый файл командой меню ФАЙЛ – НОВЫЙ. В диалоговом окне 

укажите параметры, с которыми будет создан документ (рис. 2.2). 

 

 
Рис. 2.2. Создание нового файла 

 

Появился новый документ размером 300х300 пикселов с разрешением 72 

пиксела на дюйм, у которого фоновый слой заполнен белым цветом. Работать с 

документом, не видя его реальных размеров достаточно сложно, поэтому следует 

включить направляющие линейки (ВИД – НАПРАВЛЯЮЩИЕ или CTRL+R) 

(рис.2.3). 
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Рис. 2.3 – Включение направляющих 

В правой части экрана находятся ПАЛИТРЫ (рис. 2.4). Палитр всего 13, и они 

объединены в несколько групп. Если палитры нет на экране, ее можно вызвать через 

меню ОКНО. У каждой палитры есть меню, которое вызывается стрелкой вправо. 

Чтобы палитры не мешали рассматривать изображение, их можно убрать 

клавишами SHIFT + TAB. Эти же клавиши вернут палитры на место. 

Обратите внимание на палитру Цвет. Она позволяет устанавливать цвет 

переднего плана и цвет фона. Соответствующий цвет можно выбрать, перемещая 

бегунки R (для красного), G (для зеленого), B (для синего цвета). Можно ввести 

числовое значение для каждого цвета или просто щелкнуть пипеткой для взятия 

пробы цвета. 

 

         
Рис. 2.4. Панель палитра 

 

Для изменения масштаба изображения служит панель Навигатор. На этой 

панели в уменьшенном виде можно просматривать все изображение. Видимая в 

окне его часть обозначена красной рамкой. Изменять масштаб можно 

непосредственно вводя значение процента, плавно перемещая бегунок, или щелкая 

по кнопкам Уменьшить и Увеличить (рис. 2.5). 

 

    
Рис. 2.5. Панель навигатор 
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Для выравнивания объектов по линиям, задания границ изображения, 

проверки вертикальных и горизонтальных линий удобно использовать 

направляющие (сплошные линии синего цвета) (рис.2.6). Щелкните мышкой на 

любой линейке и перетащите указатель вниз или вправо. Направляющие можно 

перемещать, используя инструмент «Перемещение». Чтобы случайно не сдвинуть 

направляющие во время работы, их можно закрепить (ВИД – ЗАКРЕПИТЬ 

НАПРАВЛЯЮЩИЕ). Их можно временно спрятать ВИД – ПОКАЗАТЬ –

НАПРАВЛЯЮЩИЕ, или удалить (ВИД – ОЧИСТИТЬ НАПРАВЛЯЮЩИЕ).  

 

 
Рис.2.6. Направляющие 

 

Удобно также работать с включенной сеткой: ВИД – ПОКАЗАТЬ – СЕТКА. 

Инструмент Кисть обратите внимание на панель свойств вверху экрана 

(рис.2.7). 

 

 
Рис. 2.7. Кисти 

 

Здесь вы можете выбрать другой инструмент, форму кисти, режим, 

мутность, течение и включить возможности пульверизатора. 

Попробуйте работать с различными формами кисти: жесткая 

круглая, мягкая круглая, spatter (брызгать), chalk (мел), star(звезда), grass (трава), lea

ves (листья), fuzzball (мокрый мяч), dry brush (сухая кисть). Выбирайте различный 

диаметр и цвет кисти. 

 
Рис. 2.8 – Кисти 
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Более детально настроить форму кисти можно, используя палитру КИСТИ. 

 
Рис. 2.9 – Кисти 

 

Свойство кисти Мутность (правильнее – прозрачность). Делает вносимый 

цвет прозрачным (цвет становится светлее, через него просвечивает предыдущее 

изображение). Пока вы не отпустили кнопку мыши (один мазок) – закрашивание 

идет ровным слоем. 

Свойство кисти Течение. Действует подобно мутности. Но при этом 

закрашивается собственный след (т.е. учитывается динамика движения кисти). 

Кнопка включить возможности пульверизатора действует, если течение 

меньше 100% (лучше 10-20%). Удержание кнопки мыши на одном месте делает 

изображение более ярким (как если бы вы держали нажатой кнопку 

пульверизатора). 

Заполните поле рисунка изображениями различного цвета и яркости. Теперь 

попробуйте поменять режим: 

Выберите жесткую круглую кисть 19 пикселей, установите цвет средней 

яркости (например, темно-голубой), и последовательно меняйте режимы, отменяя 

каждое последнее действие (CTRL+Z): 

Режим Normal (Нормальный) 

В этом режиме происходит полная замена исходного цвета на вносимый. 

Режим Multiply (Умножение) 

В этом режиме цвета исходный и вносимый "перемножаются", поэтому 

результирующий цвет получается всегда темнее исходного. 

Если вносится черный цвет, то результирующий цвет тоже становится 

черным. Белый цвет на исходный не влияет. 

Режим Screen (Экран) 

В этом режиме цвета исходный и вносимый "делятся", поэтому 

результирующий цвет получается всегда светлее исходного. Если вносится белый 

цвет, результирующий цвет становится белым. Черный цвет на исходный не влияет. 
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Режим Overlay (Перекрытие) 

В этом режиме затемняются темные цвета, осветляются светлые. В результате 

такого наложения пикселов повышается контрастность изображения. 

Режим Soft light (Мягкий свет) 

Этот режим усиливает или ослабляет цвет в зависимости от вносимого цвета 

(результат напоминает освещение рассеянным светом) 

Если вносимый цвет (считайте, что это источник света) светлее 50%-го серого, 

исходный цвет разбеливается (осветляется) идентично инструменту Dodge 

(Светлее). 

Если вносимый цвет темнее 50%-го серого, исходный цвет усиливается 

(затемняется) так же, как при работе инструмента Burn (Темнее). 

Использование чистого белого или чистого черного цвета осветляет или 

затемняет исходный цвет, но не дает соответственно белый и черный чистые цвета. 

Режим Hard light (Жесткий свет) 

В этом режиме происходит усиление (затемнение) цвета, как в режиме 

Multiply (Умножение), или ослабление (осветление) цвета, как в режиме Screen 

(Экран), в зависимости от вносимого цвета (результат напоминает освещение 

резким светом). 

Если вносимый цвет (считайте, что это также источник света) светлее 50%-го 

серого, исходный цвет разбеливается идентично режиму Screen (Экран). Если 

вносимый цвет темнее 50%-го серого, исходный цвет усиливается идентично 

режиму Multiply (Умножение) 

Использование чистого белого или чистого черного цвета идентично 

нормальному режиму. 

Режим очень удобен для создания теневых областей 

 

Режим Darken (затемнее цвета) 

В этом режиме происходит замена исходных цветов, а именно только тех, 

которые светлее вносимого, а точки, которые темнее вносимого, остаются без 

изменения 

Режим Lighten (осветление цвета) 

В этом режиме происходит замена исходных цветов, а именно только тех, 

которые темнее вносимого, а точки, которые светлее вносимого, остаются без 

изменения. 

Режим Difference (Разница) 

В этом режиме результирующий цвет равняется разнице в яркостях исходного 

и вносимого цветов. В результате такого наложения пикселов создается эффект 

негативного изображения. 

Режим Hue (Оттенок) 

В этом режиме результирующий цвет получает цветовой тон (оттенок) 

вносимого цвета, но сохраняет значения насыщенности (Saturation) и яркости 

(Luminosity) исходного цвета. Попробуйте закрасить изображение оттенком 

черного цвета. 
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Режим Saturation (Насыщение) 

В этом режиме результирующий цвет получает насыщенность вносимого, но 

сохраняет оттенок (Hue) и яркость (Luminosity) исходного. На изображения в 

градациях серого никакого влияния не оказывает. 

Режим Color (Цвет) 

В этом режиме результирующий цвет получается с яркостью (Lummosily) 

исходного, но с оттенком (Hue) и насыщенностью (Saturation) вносимого. Это 

позволяет сохранить серую шкалу. Находит широкое применение для цветного 

тонирования монохромного изображения. 

Режим Luminosity (Свечение) 

Правильнее – яркость. В этом режиме результирующий цвет получается с 

оттенком (Hue) и насыщенностью (Saturation) исходного цвета, но 

с яркостью вносимого. В серой шкале результат совпадает с вносимым тоном. Этот 

режим по своему результату противоположен режиму Color (Цвет) 

Режим Dissolve (Растворение) 

Чтобы увидеть действие этого режима, нужно дополнительное условие. 

Установите в поле Opacity (Мутность) значение 50%. 

В этом режиме происходит замена исходного цвета на вносимый со 

случайным распределением и учетом прозрачности. Результат особенно заметен при 

больших размерах инструментов Paintbrush (Кисть) или Airbrush (Аэрограф) и 

частичной мутности. 

 

Задание 1. Выделение областей для редактирования и преобразования 

изображений 

В этом упражнении нам предстоит вырезать изображение цветка из 

фотографии-оригинала и поместить цветок в новое изображение, применив 

растушевку (сглаживание) краев. 

1. Откройте файл «Кувшинка» (рис.2.10). 

2. Выберите инструмент Масштаб  и растяните рамку вокруг цветка, для 

увеличения картинки. 

3. Теперь выберите инструмент Лассо . 

4. На панели Параметров установите параметр Растушевка равным нулю. 

5. Щелкните на краю цветка и тщательно обведите его контур, перетаскивая 

указатель инструмента Лассо. Постарайтесь не отпускать раньше времени кнопку 

мыши. Если это случится, вы потеряете часть объекта: выделенная область 

автоматически замкнется по кратчайшей линии. Ну а если такое все же произошло, 

поместите указатель инструмента внутрь выделенной области (возле него появится 

значок в виде пунктирного прямоугольника). Нажмите клавишу Shift и, удерживая 

ее, продолжайте рисовать рамку вдоль контура цвета. 

6. Когда вы приблизитесь к той точке, с которой начали рисование рамки, 

отпустите кнопку мыши. Рамка замкнется, и выделение цветка будет завершено. 

7. Выберите команду меню Редактирование - Копировать. 

8. Создайте новый файл. В окне диалога автоматически будут установлены 

нужные значения размеров изображения. Каждый раз, когда вы копируете или 
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вырезаете выделенную область изображения в буфер обмена, а затем создаете 

новый документ, его размеры устанавливаются так, чтобы точно вместить 

скопированное изображение. 

9. В окне диалога Имя установите переключатель Прозрачный в разделе 

Содержимое. Прозрачные области изображаются шахматным фоном в окне вновь 

созданного документа. 

10. Выберите команду Редактирование - Вставить. На рис. 2.11 показан 

результат, полученный после вставки копии изображения цветка в новый документ. 

 

 
Рис. 2.10. Фотография цветка 

 

 
Рис. 2.11. Копия изображения цветка вставлена в новый документ 

 

Теперь попробуйте применить тот же метод, но на этот раз с растушевкой 

границ выделенной области. 

11. Вернитесь к исходному изображению цветка. 

12. Если ранее построенная выделенная область еще активна, щелкните за ее 

пределами, чтобы отменить выделение. 

13. На панели Параметров введите число 10 в текстовое поле Растушевка. 

Оставьте флажок Сглаживание установленным для получения более гладких краев. 

14. Теперь с помощью инструмента Лассо выделите изображение цветка так 

же, как вы делали это в предыдущем упражнении, но, может быть, с несколько 

меньшей тщательностью. 
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15. Скопируйте изображение в буфер обмена. 

16. Создайте новый файл. Установите переключатель Белый в разделе 

Содержимое окна диалога Имя. 

17. Вставьте скопированное изображение. Результат показан на рис. 2.12. 

 

Обратите внимание на мягкие, растушеванные края выделенной области. Этот 

эффект производит очень приятное впечатление, а достигается без каких бы то ни 

было дополнительных усилий. Попробуйте использовать другие значения радиуса 

растушевки. Попробуйте сбросить флажок Сглаживание. Запомните 

использованную в этом упражнении методику растушевки, она пригодится в 

дальнейшем при создании коллажей. 

 
Рис. 2.12. Выделенная область с растушеванной границей 

 

Задание 2. Замена фона 

1. Перейдите к рисунку с изображением. Постарайтесь улучшить качество 

изображения, воспользовавшись командой Изображение → Регулировки → Авто 

Уровни (<Ctrl>+<Shift>+<L>) и окном Кривые Изображение → Регулировки → 

Кривые (<Ctrl>+<M>) 

2. Выделите с помощью инструмента Волшебная палочка  задний фон 

изображения. 

3. Теперь необходимо несколько расширить выделение, чтобы исключить 

случайные области. Для этого выполните команду Выделение → Модифицировать 

→ Расширить. В открывшемся окне Выбор расширения установить <Расширить на 2 

пикселя> 

4. Не отменяя выделения, перейдите к рисунку с изображением пейзажа. 

Выделите всё изображение командой Выделение → Всё (<Ctrl>+<A>). 

5. Скопируйте выделенное изображение в буфер обмена командой 

Редактирование → Копировать (<Ctrl>+<C>). 

6. Вернитесь к рисунку с изображением человека. Не снимая выделения 

выполните команду Редактирование → Вставить В (<Ctrl>+<Shift>+<V>). 

Инструментом Перемещение  выровняйте фон так, чтобы он «вписывался» в 

композицию рисунка. 

7. Объедините слои командой Слой → Выполнить сведение. 

8. Готовое изображение сохраните в своей папке. 
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Задание 3. Градиентная заливка 

1. Перейдите к рисунку с изображением. Постарайтесь улучшить качество 

изображения, воспользовавшись командой Изображение → Регулировки → Авто 

Уровни (<Ctrl>+<Shift>+<L>) и окном Кривые Изображение → Регулировки → 

Кривые (<Ctrl>+<M>) 

2. Выделите с помощью инструмента Волшебная палочка  задний фон 

изображения. 

3. Теперь необходимо несколько расширить выделение, чтобы исключить 

случайные области. Для этого выполните команду Выделение → Модифицировать 

→ Расширить. 

4. В открывшемся окне Выбор расширения установить <Расширить на 2 

пикселя> 

5. Не отменяя выделения, выберите инструмент Градиент. 

6. Инструментом Цвета переднего плана и фона установите цвета 

переднего плана и фона, выбрав в окне Сборщик цветов составляющие. 

7. На панели инструмента Градиент выберите тип градиента Foreground to 

Background (от цвета переднего плана к фону). 

8. Поэкспериментируйте с различными направлениями и типами 

(Линейный, Радиальный, Угловой, Отражённый, Ромбовидный) и видами 

переходов градиента. 

 

Задание 4. Перевод изображения из чёрно-белого в цветное 

1. Откройте файл fruits.tif (рис. 2.13) 

2. Поверх слоя с изображением создайте новый слой командой Слой → 

Новый → Слой... (<Ctrl>+<Shift>+<N>) (можно воспользоваться кнопкой Создать 

новый слой, расположенной на палитре Слои). 

3. На палитре Слои в выпадающем списке Установить режим 

смешивания установите режим Цвет. Выберите инструмент Кисть  с 

твёрдыми краями. Выбирая необходимые цвета инструментом Цвета 

переднего плана и фона, начните раскрашивать изображение.  

4. Объедините слои командой Слой → Выполнить сведение. 

 
Рис. 2.13. Перевод изображения из чёрно-белого в цветное 

 

Задание 5. Перевод изображения из цветного в чёрно-белого 

1. Откройте любое цветное изображение. 
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2. Переведите изображение в чёрно-белый режим командой Изображение → 

Режим → Чёрно-белый. После этого вся информация о цвете данного изображения 

стирается. В результате должна получиться обычная чёрно-белая фотография. 

3. На палитре Слои в выпадающем списке Установить режим смешивания 

установите режим Цвет 

 

 

Задание 6. Слияние картинок 

1 способ 

Обязательное условие – первая и вторая фотографии должны быть 

одинаковыми по размеру (хотя бы по ширине). 

Сделайте активной фотографию1. Перейдите в режим быстрой маски, нажав 

на клавиатуре «горячую клавишу» <Q>. 

Установите цвета фона и переднего плана белый и чёрный. 

Инструментом Градиент, залейте изображение сверху вниз с переходом от 

цвета переднего плана к цвету фона. Поскольку Вы в режиме Быстрой Маски, то 

белый цвет выглядит прозрачным, а черный красным. Чем краснее, тем прозрачнее 

будет это место на картинке. 

Вернитесь в обычный режим редактирования нажатием «горячей клавиши» 

<Q>.  

Вы получите выделение, большая часть которого будет невидимой, так как 

пиксели выделены частично. 

Сделайте активной вторую фотографию. Выделите всё изображение командой 

Выделение → Всё, или воспользуйтесь «горячими» клавишами <Ctrl>+<A>. 

Выделенное изображение поместите в буфер обмена с помощью команды 

Редактирование → Копировать (<Ctrl>+<C>). 

Снова сделайте активной первую фотографию. Вставьте изображение 

командой Редактирование → Вставить В (<Ctrl>+<Shift>+<V>). 

Объедините слои командой Слой → Выполнить сведение. 

 

2 способ 

Сделайте активной фотографию 1. 

Выделите изображение любым инструментом выделения, например 

Магнитным Лассо . 

Командой Выделение→Растушевать модифицируйте выделение так, чтобы 

появилась ещё область частично выделенных пикселей. 

На сколько пикселей расширять, укажите сами (например, на 60). 

Выделенное изображение поместите в буфер обмена с помощью команды 

Редактирование → Копировать (<Ctrl>+<C>). 

Перейдите ко второй фотографии. Вставьте изображение командой 

Редактирование → Вставить (<Ctrl>+<V>). 

Уменьшите размер слоя изображения 1. 

Объедините слои командой Слой → Выполнить сведение. 
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Рис. 2.14. Сведение изображений 

 

Задание 7. Создание озера 

Средствами графического редактора можно не только преобразовывать, 

ретушировать и создавать изображения, но и коренным образом изменять их, внося 

свои идеи и настроения. 

Допустим, нам бы хотелось видеть вместо тропы озеро, самое настоящее, с 

настоящим отражением. Вы можете подобрать для этой цели любой пейзаж (или не 

пейзаж). 

 

Первым делом надо обвести контур будущего водоема. Для этого можно 

использовать любые средства построения масок или выделения части изображения. 

Самый простой вариант, которым и воспользуюсь, – применить инструмент «лассо», 

активизируемый клавишей [L] или выбираемый мышкой из палитры инструментов. 

Удерживая нажатой левую кнопку мышки, провожу линию берега. Когда область 

выделена и ее форма отвечает творческому плану, создаем новый слой, щелкая 

мышкой по кнопке в палитре слоев. Новый слой Layer 1, на котором пока ничего 

нет, сразу становится активным, то есть рабочим, но рисовать на нем можно лишь в 

пределах, ограниченных созданным шаг назад выделением. 

Теперь надо выбрать цвета для тонирования воды. Пипеткой с фотоснимка 

снимаем один из самых темных оттенков будущего отражения. Это будет передний 

цвет. В качестве цвета фона выбираем один из наиболее светлых цветов. Теперь 

воспользуемся растяжкой, или градиентной заливкой, чтобы окрасить выделенную 

область на слое Layer 1 снизу-вверх от темного к светлому. С помощью растяжки 

мы задали изменение коэффициента отражения поверхностью воды. Чтобы 

сымитировать рябь, прибегнем к фильтру Add Noise, вызываемому через меню 

Filter/Noise. Распределение шума должно быть равномерным, то есть Uniform, а его 

количество надо подбирать, исходя из размеров картинки и творческого замысла. 

Рекомендую 15-20 (на «вкус»). Снимаем выделение (CTRL+D). Начинаем строить 

отражение. Для этого надо скопировать фотоснимок на новый слой. Выбрав в 

палитре слоев Background, перетягиваем его мышкой на кнопку создания нового 

слоя, расположенную в низу палитры Layers. Слой под названием Background copy 

появился между слоями Background и Layer 1. Отражение надо переместить на 

самый верх, поэтому перетягиваем его в палитре слоев и отпускаю над Layer 1 (см. 

рис.2.15). 
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Рис.2.15. Преобразование изображения 

 

Собственно, отражение. При активном слое Background copy вызываем Edit → 

Transform → Flip Horisontal. Эта команда зеркально отражает слой в горизонтальном 

направлении, что нам и требуется. Не спутайте ее только с командой Flip Horisontal 

из меню Image/Rotate Canvas, которая переворачивает всю композицию – «холст», 

включая все слои. Если бы мы не строили такое «косое» отражение, а выбрали бы 

объект, отражающийся прямо перед собой, нам было бы достаточно предыдущего 

шага (только используя Flip Vertical ). Однако слишком много «бы». Короче, мы 

пошли другим путем, и поэтому потребуется снова вернуться к команде Edit → 

Transform и выбрать Rotate, чтобы завершить «переворачивание» изображения. 

Появится вот такая прямоугольная рамка, вращать которую можно за ее угловые 

точки. После того, как угол будет верным, не забудьте нажать Enter (тем самым 

согласившись с изменениями). Отражение слой Background copy, надо смесить на 

«юго-восток». Можно воспользоваться клавишами вверх/вниз/вперед/назад при 

активном инструменте перемещения для более точной регулировки расположения 

отражения. Целиться пока трудно, да и не надо, так как позже положение отражения 

можно будет подправить очень точно и, главное, наглядно. Из слоев Layer 1 и 

Background copy организуем срезаемую группу. Для этого надо, удерживая нажатой 

клавишу [Alt], щелкнуть мышкой по линии, разделяющей эти слои в палитре Layers. 

В момент, когда можно щелкать, курсор примет форму двух кружков со стрелкой 

посередине. 

Сейчас можно, воспользовавшись инструментом перемещения, подправить 

сдвиг отражения до максимально реалистичного. Для наложения пикселов надо 

переключить в палитре слоев для слоя Background copy режим с Normal на Multiply. 

Режим Multiply задает «умножение» цветов, при котором результирующий цвет 
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всегда будет темнее исходного, то есть взятого с нижнего слоя. Если вам покажется, 

что отражение вышло слишком темным, можно затемнить его другим способом: 

обычным инструментом, отрегулировав предварительно Opacity. Объединим слои 

Background copy и Layer 1 командой Merge Down. Ее можно вызвать из меню Layer, 

из меню палитры Layers или просто клавишами [Ctrl]+[Е]. В природе отражение 

столь правильным не бывает. «Размоем» его фильтром Motion Blur (меню 

Filters→Blur). Параметры: угол 0 градусов, дистанция – 4 пикселя. Для прозрачной 

воды требуется добавление прозрачности. В палитре слоев для Layer 1, на котором у 

нас сосредоточена вся вода, изменяем Opacity до 85-90%. И последнее. У нас же 

осеннее настроение:) Для большей реалистичности просто необходим фильтр 

Diffuse Glow из меню Filters → Distort. Он добавит немного осеннего «мусора» на 

воде. Параметры на рисунке 2.16. 

   
 

 
Рис.2.16. Финальная работа 

 

Контрольные вопросы 

 

1. Понятие компьютерной графики. 

2. Понятие растрового изображения. 

3. Кодирование графической информации. Цветовые модели. 

4. Перечислить достоинства и недостатки различных типов графики. 

5. Дать характеристики цветовым моделям. 

6. Дать определение и характеристику палитрам. 
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7. С помощью какой команды можно изменить размер изображения, 

находящегося на каком-либо слое? 

8. Какое назначение инструмента "Штамп"? 

9. Какой инструмент служит для выделения областей одного цвета? 

10. Как называется инструмент, позволяющий залить изображение двумя плавно 

перетекающими друг в друга цветами? 

11. Для чего применяются фильтры? 

12. Понятие глубины цвета. 

 


